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CHAPTER

TWO

WHAT IS THE PLATING GENERATOR?

The creates customised, reconfigurable panel lines and details on top of your 3D Model.

This add-on is for 3D Modellers and concept artists who find it time consuming to create interlocking panels and details
on 3D Models such as spaceship hulls, but still want a unique look and feel. It uses specially designed algorithms to
generate different patterns.
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CHAPTER

THREE

FEATURES

• Generate a panel lines or scatter smaller objects using a random seed.

• Use on flat or curves surfaces.

• Choose from a range of completely customizable plating patterns.

• Create your own objects libraries or choose from the standard default library.

• The objects can either be created and edited separately or integrated into the base object.

• Go back and change the patterns and greebles from a fixed control panel at any time when they are created as
separate objects.

• Create from a whole based mesh or on a sub selection of faces.

• Control the depth of the grooves, heights of the panels, thickness of the grooves, make corners rounded, and add
bevel effects.

• Add your own materials and vary panel color through vertex colors.

• Greebles can either be overlapping or non-overlapping.

• Greebles can either conform to the shape of the face or maintain their proportions.

• Option to completely remove the grooves and leave the plates intact.
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CHAPTER

FOUR

HOW DOES IT WORK?

For instance, a manual method is to extrude edge loops over and over, which can be very time consuming. The more
detailed you want the mesh to be, the longer it will take:

Fig. 1: Manual Process Automated

This add-on greatly speeds up the process, allowing you to quickly create a selection in a plating pattern and and extrude
the edges accordingly.

Fig. 2: Plating Generator in Action

combined with the addon can quickly create detailed models which can then be further refined. It can also be used to
create libraries of curated objects.

4.1 Installation

4.1.1 Installation Files

You will be provided with the following files:

• For Blender installation (do not unzip, install via Blender UI):

– plating_generator_greebles.zip - the main add-on file.

• Libraries and samples (do unzip!):

– greeble_libraries.zip - a bonus set of greeble libraries.

– plating_generator_greebles_samples_unzip.me.zip - A set of sample.blend files demonstrating the main
add-on’s setup.

– animation_nodes_plating_gen_samples_unzip.me.zip - A set of sample.blend files demonstrating the
animation node setup ( required).
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4.1.2 Installation Steps

1. Go to Edit -> Preferences.

2. Select the Add-ons tab on the left if it is not already.

3. Select the Install. . . button along the top.

4. This will open a file dialog where you should navigate to where you have downloaded the plat-
ing_generator_greebles.zip file. This file should not be unzipped.

5. Then, click the Install add-on from file button.

6. Search for the add-on by typing Plating Generator in the search box if it does not already appear.

7. Make sure the checkbox next to the Add-on (Mesh: Generate Plates with Greebles) is ticked:

Fig. 3: Plating Generator Installed

If you have any issues do not hesitate to get in touch via info@configurate.net.

4.2 Getting Started

The tool can be used in either Object or Edit Face Mode, with faces selected.

1. Select some faces on your object.

2. Right-click in the viewport and a menu should appear.

3. In the menu there should be a section called Plating Generator, which is also available from the Mesh menu at
the top of the viewport.

4. If you want to create a new plating object and leave the original object intact in a non-destructive way you have
the following options as a starting point:

8 Chapter 4. How does it work?
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Fig. 4: Plating Generator in the right-click context menu.
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• Add Plates: Add a panel line pattern as a new object using the faces you have selected.

• Add Greebles: Add greeble objects as a new object using the faces you have selected.

5. If you want to modify the existing mesh you have the following options:

• Add Plates to Mesh: Add panel lines directly to your mesh.

• Add Greebles to Mesh: Add greeble objects directly to your mesh.

6. If you want to add a Plating Generator modifier to your object, you can select from the Modifiers section.

These options are described below.

4.2.1 Non Destructive Workflow

If you don’t want to damage your original object, these options will create a new separate object, called <original
name> plating, and add a base Level of either Plates or Greebles:

Add Plates

Selecting the Add Plates option will automatically add a basic plating pattern in the form of a new Blender object:

Add Greebles

Selecting the Add Greebles option will automatically add a set of basic greebles in the form of a new Blender object:

Changing Properties for Object

When you have either added Plating or Greebles you can then change the object’s properties using the built-in side
panel available on the right hand side when the new object is selected. If this is not visible, press the n key in the
viewport to display Blender’s properties panel, and select the Plating Generator side tab:

These properties are descibed in more detail here.

4.2.2 Destructive Workflow

This will edit the existing object, which can be advantageous if you wish to create deeper plates or embedded greebles.
However it is more difficult to undo the operation.

Tip: Disappearing Panel?

During this mode, which is a one-time operation, Blender’s panel can disappears if you accidentally click outside. You
can bring it back as long as you have not performed another action by pressing F9.
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Fig. 5: Plates Properties Panel

Add Plates to Mesh

Selecting the Add Plates to Mesh option will automatically add a basic plating pattern directly on the mesh:

Add Greebles to Mesh

Selecting the Add Greebles to Mesh option will automatically add greebles directly on the mesh:

Add Panel Lines to Mesh

Selecting the Add Panel Lines to Mesh option will automatically add panel lines using selected edges:

This uses the same Properties as the Add Plates to Mesh function

4.2. Getting Started 11
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Changing Properties for Operation

You can then change the object’s Properties using the bottom left hand side panel. You may need to expand the panel
to see all the options:

These properties are descibed in more detail here.

4.3 Control Panel

When using a Non Destructive Workflow, if you select a plating object the Plating Generator Panel will show the
parameters for the object. This panel is on the right hand side of the viewport. If this is not visible, press the n key in
the viewport to display Blender’s properties panel, and select the Plating Generator side tab:

Fig. 6: The Plating Generator Properties Panel
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4.3.1 Main Controls

Fig. 7: Main Control Panel

These control the overall randomisation for the Plating Generator and whether to automatically update the object when
parameters are changed:

Fig. 8: The Master Seed Controls the randomisation of all the Generator code and will change what the Plating object
looks like within the parameters of the add-on.

Fig. 9: This button will change the master seed parameter at random so you can quickly try out different variations.

4.4 Levels

4.4.1 Introduction

When you have created a Plating/Greeble Object using a Non Destructive Workflow, you can add extra levels of plates
or greebles. For each level, you can then choose to either build on top of the original object or previous levels. They
are similar in concept to layers in Photoshop or Gimp.

This can give rise to new and interesting combinations of effects which you can then save as a Preset for future use.

Warning: With Great Power. . .

Add levels with caution!

Adding more than 3 or 4 levels will add more computation, so Blender’s processing will slow down accordingly
and may appear to freeze.

New levels are disabled by default to prevent Blender automatically re-calculating the moment a level is added.

4.4. Levels 13
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Fig. 10: This button will update the object with the parameters specified in the panel.

Fig. 11: When turned on, any parameter changed in the Plating Generator panel will automatically update the object.
If switched off, you will need to manually press the Update button to update the selected object.

Fig. 12: Auto Update on while randomly changing the main seed.

Fig. 13: Levels at work

Fig. 14: Levels at work
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4.4.2 Levels Panel

Fig. 15: Levels Control Panel, with some example levels. Here, the ‘Upper Tier’ level is selected.

• Add: Add a new Level.

• Copy: Make a copy of the selected level.

• Up/Down Arrows: Move the selected level up and down the stack.

Expanding the Levels sub section will give you the ability to add new Levels to the plating object. When you first add
a new Plating Object, a single level called “Base Level” is added:

Fig. 16: Controls for each level.

• Selector: By clicking on a level, the row will be highlighted and you will be able to access the properties below
the panel.

• Type: Icon showing the type of level (Plates or Greebles)

• Color: A random color is assigned to a level for organisation purposes which you can change if you wish. It has
no effect on the object.

• Name: Name for the level.

4.4. Levels 15
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• Seed: The seed associated with the level.

• Visible: Whether we can actually see the level of not: It will still be processed if it is enabled. This helps with
adding invisible framing elements for greebles or plating.

• Enabled: Whether the level is enabled for processing or not. If other levels are dependant on this level, they will
no longer be displayed or processed.

• Delete: Delete the level from the plating object.

4.4.3 Use

To add a new Level, with the plating object selected:

1. Expand the Levels sub-section of the panel:

2. Click the “Add” button to create a new Level:

3. By default the Level will be disabled allowing you to set up some properties before you add a new Level.

4. In the Properties panel, try changing the type of Level to “Greeble”:

16 Chapter 4. How does it work?
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5. Now, enable the Level by clicking the checkbox either in the Properties panel or in the Levels panel. You should
see the object update with the new Level, unless it is hidden by the objects in the other Level:

4.4.4 Building on other Levels

1. The Build On option allows you to choose whether the level builds on the Original Object or Previous Levels:

2. If you select a previous level, and that level was a “Plating” type, you can choose whether to add this level to the
Tops or the Sides of the Plates (or both by pressing the shift key):

4.4. Levels 17
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4.4.5 Selection

1. The Properties section allows you to further configure a selection:

2. You have the following selection options when you are either building on the original object, or on top of a level:

• Face Amount: The percentage of faces from the selection to build on. On the original object, this will
randomly select faces. Clicking the circular refresh button allows you to randomize the selection.

• Plate Amount: The percentage of plates or greebles to build on. On the original object, this will randomly
select existing plates. Clicking the circular refresh button allows you to randomize the selection.

• Only Select Remaining Faces: Only pick from the faces that haven’t already been used by the levels below.
Useful for keeping the effects from overlapping.

3. You can control the minimum size of the faces that will have the Level applied by using the Minimum Face
Area property, which is useful for stopping plates or greebles being added to very small faces.

Fig. 17: Here, one plating level is being built onto another, with the green level being applied to the tops and sides of
the base purple level. The Minimum Face Area property is used to stop the effect being applied to smaller faces (such
as some of the smaller sides).
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4.4.6 Changing Other Properties

When you click a level, it gets selected and the associated Properties appear in the panel below it:

Each of the different properties are described in this section.

4.5 Properties

4.5.1 Plating Properties

General Properties: Plates

• Level Color: Color to denote level for organisational purposes. Has no direct effect on object.

• Level Name: The name of the Level for these properties.

• Enabled Checkbox: Whether the Level is activated or not.

• Plates/Greebles: Whether we are creating Plates or Greebles.

Plating Pattern

Configure how the plating pattern is created.

Pattern Types

Choose between different patterns to create the panelled effect. Each has it’s own set of options:

4.5. Properties 19
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Fig. 18: Main properties panel for the plating effect.

Fig. 19: Plating General Properties
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Criss Cross

Create intersecting edge loops. The following options apply:

4.5. Properties 21
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• Random Seed: generate a different selection based on the whole number given here.

• Amount: the percentage of plate cuts generated.

• Subdivisions: this will subdivide the selected faces before applying the pattern.

Ruby Dragon

Randomly select faces by walking around the mesh. The following options apply:

• Random Seed: generate a different selection based on the whole number given here.

• Percentage: The percentage of grooves to add.

• Subdivisions: this will subdivide the selected faces before applying the pattern.

• Triangles Random Seed: Change where triangular parts of the grooves are added independent to the main
random seed.

• Triangulation: As a percentage, how many triangles are added to the standard pattern.
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Triangular

Similar to Criss-Cross, with added triangular accents added randomly to the grooves. Additional properties:

• Triangles Random Seed: Change where triangular parts of the grooves are added independent to the main
random seed.

• Amount of triangles: As a percentage, how many triangles are added to the standard pattern.

• Subdivisions: this will subdivide the selected faces before applying the pattern.

4.5. Properties 23
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Rectangles

Create sets of rectangles of varying sizes on the object. This is a more experimental version where some lines may not
intersect, but changing the seed may remove these results.

• Rectangle Random Seed: Change where rectangles are added independent to the main random seed.

• Rectangle Amount: Number of rectangles to cut out.

• Rectangle Width Min: Minimum number of width edges for rectangles.

• Rectangle Width Max: Maximum number of width edges for rectangles.

• Rectangle Height Min: Minimum number of height edges for rectangles.

• Rectangle Height Max: Maximum number of height edges for rectangles.

• Subdivisions: this will subdivide the selected faces before applying the pattern.
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Morse Brown

Inspired by , this is a combination of the criss-cross pattern combined with rectangle shapes and triangles. This is a
more experimental version where some lines may not intersect, but changing the seed may remove these results.

• Rectangle Random Seed: Change where rectangles are added independent to the main random seed.

• Rectangle Amount: Number of rectangles to cut out.

• Rectangle Width Min: Minimum number of width edges for rectangles.

• Rectangle Width Max: Maximum number of width edges for rectangles.

• Rectangle Height Min: Minimum number of height edges for rectangles.

• Rectangle Height Max: Maximum number of height edges for rectangles.

• Slices Random Seed: The number of edge loops to create on the pattern. If they intersect with a rectangle, they
will be terminated.

• Slices Amount: Number of slices to make in the pattern.

• Triangles Random Seed: Change where triangular parts of the slices are added independent to the main random
seed.

• Amount of triangles in slice: As a percentage, how many triangles are added to the sliced pattern.

• Subdivisions: this will subdivide the selected faces before applying the pattern.

4.5. Properties 25
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Selected Edges

Use the edges that have been already selected. For this mode to work, select edges in Edge Edit mode instead.

Add Grooves by Face Angle

When activated, this will also add grooves wherever the edge of two faces match that angle.

• Edge Angle: The angle where grooves will be added.

• +/-: How much deviation around the angle to match edges by.

26 Chapter 4. How does it work?
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Plates

Configure how the plates are created.

Plate Taper

• Amount: This will shrink the tops of the plates. By increasing the amount, the plates should become smaller.
You can also use negative amounts to make the plate tops larger.

Plate Heights

These options will vary the heights of each plate at random, which should allow you to create more varied effects:

4.5. Properties 27
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• Match Heights: Keep the Min and Max Height properties the same.

• Min Height: The minimum height of plates*

• Max Height: The maximum height of the plates*

• Random Seed: This will vary the random pattern that the heights are set at, without changing the plating pattern.

* note that the Min Height can be higher than the Max Height!

Plate Bevel

Add a bevel effect around the plates:

• Amount: How bevelled are the top of the plates.

• Segments: How many segments the plate bevel has.

• Plate Bevel Type: The type of Bevel to apply. See the .
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Grooves

This section controls the grooves between the plates.

• Clamp Groove Width: prevent the grooves from overlapping geometry.

• Width: the width of the grooves between the plates.

• Depth: The depth of the grooves between the plates.

• Groove Segments: Number of segments inside the grooves.

• Side Segments: Number of segments on the side of the plates.

Groove Bevel

Add a bevel effect around the grooves:

• Amount: How bevelled are the groove edges between the plates.

• Segments: How many segments the groove bevel has.

• Groove Bevel Type: The type of Bevel to apply. See the .
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Corners

For the corners of the plates, you can also add a curved bevel to give rounded corners.

• Match Corners: when checked, both the Major and Minor corners will be kept the same.

Major Corners

Major corners are the surrounding corners of the original face selection:

• Amount: bevel width of the corners.

• Segments: the number of segments in the bevel.

• Major Corner Bevel Type: The type of Bevel to apply. See the .
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Minor Corners

Control the opposite to major corners:

• Amount: bevel width of the corners.

• Segments: the number of segments in the bevel.

• Minor Corner Bevel Type: The type of Bevel to apply. See the .
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Rivets

You can add rivets to the corners of the plates. The default shapes are standard ico spheres.

• Use Rivets: whether to add rivets or not.

• Use Custom Rivet: instead of using the default spherical rivet, you can pick a custom scene object in the drop-
down box.

• Distance from Corner this will determine the distance of the rivets from the corners.

• Diameter: diameter of the spherical rivets.

• Subdivisions: level of detail for the rivets.

• Material Index: the index of the material slot to use for the rivets. -1 will disable assigning a material.
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Materials

Add custom materials to the plating panels.

By default, the plates will be created with the same materials as the selected faces. The following parameters let you
override that behavior with materials you have defined:

Groove Material

4.5. Properties 33
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Specify a material for the grooves via a drop-down box that shows you existing materials.

Warning: In the Non Destructive Workflow the grooves are removed by default, so you may not see the effect.
Uncheck the Remove Inner Grooves property to see them.

Plating Materials

Fig. 20: Plating effect with different materials applied to each set of plates.

This section allows you to specify different materials to randomly applied to each plate. A plate is a group of faces
between the grooves.

It has the following parameters:

• No. of Plating Materials: The number of different materials to be randomly applied to the plates. Increasing
this number will create new material drop-down boxes for you to populate*:

* There is a known bug in Blender where by pressing the ‘X’ the menu will disappear in the Destructive
Workflow. Use the number of plating materials parameter to control the number of materials instead.

• Add Vertex Colors: Add a vertex color group called plating_color to the plates. A random color value is assigned
per plate.
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• Vertex Color Random Seed: You can change these random colors by altering thia value. You can then use this
in a material shader to control the color of a material:

Fig. 21: Different seed values being applied to the vertex color layer.

Other Options
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Fig. 22: Simple example of a vertex color layer controlling a material.
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• Select Groove Geometry: select the created groove faces.

• Select Plate Geometry: select the created faces for the plates.

• Mark UV Seams: mark UV Seams around the plates for texture mapping purposes.

• Edge Split: this will split the groove edges to make sure the outer plates remain smooth.

• Remove Grooves: completely remove the grooves and just leave the plates. Useful with Solidify modifier.

• Remove Inner Grooves: This allows you to remove just the inner groove faces. Useful in the Non Destructive
Workflow when you just want the plates and sides.

• Edge Selection Only: only select the edges, without the mesh being edited. Useful if you want to perform
custom operations on the selection.

• Shade Smooth: All faces will have their shading set to smooth.

UV Projection

The Plates will automatically have Blender’s algorithm applied to generate UVs for texturing.

• UV Projection Limit: This controls how faces are grouped: a higher limit will lead to many small groups but
less distortion, while a lower limit will create fewer groups at the expense of more distortion.

Smoothing

When checked, the whole object will have applied and is controlled by the Auto Smooth Angle.

4.5. Properties 37
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4.5.2 Greeble Properties

The Greeble objects are aligned randomly onto quad faces. The overall shape of each greeble is deformed to follow the
face it is being placed on unless the Maintain Aspect Ratio property is checked.

General Properties: Greebles

• Level Color: Color to denote level for organisational purposes. Has no direct effect on object.

• Level Name: The name of the Level for these properties.

• Enabled Checkbox: Whether the Level is activated or not.

• Plates/Greebles: Whether we are creating Plates or Greebles.
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Fig. 23: Main properties panel for adding greebles.

Fig. 24: Greeble General Properties
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Greeble Pattern

• Mode: This has the following options:

– Overlapping: The greeble objects are randomly placed on a face and can overlap.

– Non-Overlapping: The greeble objects are placed so that they do not overlap.
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Each mode has different parameters because each uses a different approach to placing the objects:

Overlapping

• Greeble Random Seed: by changing this value, you will create different random patterns.

• Greeble Amount: The number of greeble objects to be put on the object.
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Non-Overlapping

• Greeble Random Seed: by changing this value, you will create different random patterns.

• Overall Coverage %: The percentage covering the object.

• Greeble Division Levels: Each face will be allocated spaces for the greebles. Higher levels means more objects
will be fit onto each face. The user interface is restricted but you can enter higher values.

• Greeble Deviation: This is how much each greeble’s size varies on a face. A value of 0 will create a uniform
set of sizes, where a value of 1.0 will create irregular sizes.

Greeble General Parameters

• Min Width: The minimum width of a greeble object relative to the face it is on.

• Max Width: The maximum width of a greeble object relative to the face it is on.

• Min Length: The minimum length of a greeble object relative to the face it is on.

• Max Length: The maximum length of a greeble object relative to the face it is on.

• Min Height: The minimum height of a greeble object relative to the face it is on.

• Max Height: The maximum height of a greeble object relative to the face it is on.
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Greeble Objects from Library

4.5. Properties 43



Plating Generator

There are several basic objects supplied as a default greeble library to create Greeble effects from. You can choose to
add squares in different patterns, L shapes, T shapes, or cylinders.

There are settings for each object and by hovering the mouse you should see a description for each one. They are:

• A thumbnail of the greeble:. Clicking on this thumbnail shows you which other objects you can choose from
within that greeble library.

• A drop down menu showing which greeble library the object comes from. If you have other greeble libraries
installed, you can select them here.

• Maintain Aspect Ratio: This will keep the proportions of the object’s width and height in case you do not want
the object stretched.
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• Material Index: Override the material on the greeble with a material index slot. By default, these objects will
inherit the material of the object. Values of -1 will not override the material.

• Height Override: This will automatically override the height of each greeble so that you can stop shapes stretch-
ing unnecessarily.

• Coverage: This controls the amount this Greeble will cover the surface relative to the total number of greebles
set under the ‘Greeble Pattern’ section. This allows you to adjust the relative amount of each object on the total
number of greeble objects. For instance, if you have 50% L shapes and 100% T shapes, the effect will roughly
have half as many L shapes as T shapes.

These parameters also apply to Greeble Objects From Scene.

Greeble Objects From Scene

The add-on allows you to add your own greebles from scene objects.
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By clicking “Add” you will be able to select the scene object. Once selected, the objects will be added as Greebles.
You can adjust the coverage and other parameters of these objects just like the library greebles.
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The objects will be added to a face relative to the same direction as the z-axis of the original object.

Greeble Orientation

This section allows you to point the greebles in a customized direction and to control the random rotation of the greebles.

• Use Custom Direction: By default, the greebles point out from the Mesh along the normal of the faces they are
on. This option allows you to point the greebles in a custom direction along the vector defined under Outwards
Direction. A value of (0,0,1), for instance, will point all Greebles in the Z direction:

• Rotation: The greebles are randomly rotated in 90 degree turns when they are placed on the mesh. You can
control or disable this function:

– Greeble Random Rotation Seed: this will change the random pattern of greeble rotations without affecting
their overall positions.

– Do not randomly rotate: This disables random rotation, and allows you to specify the number of 90 degree
turns by changing Number of 90 degree rotations.

4.6 Update/Copy/Select

If you want to:

• Change the face selection for the generated plates

• Copy the plates you already have to a new area on the object

• Get the selection you used to create the plating object

You have the following options:
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Fig. 25: Default: Greebles follow the face normals.
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Fig. 26: Custom Direction: All greebles point in the same customisable direction.
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4.6.1 Update Selection

Fig. 27: Updating the selection used to generate plates.

This will update the plating object to change to a different set of faces on a mesh.

1. On the main object you are creating plate objects from, select a new set of faces you wish to change to in Face
Edit Mode. This can also be existing faces you have changed.

2. Right-click and select Plating Generator -> Update Plating Selection For:.

3. In the menu that appears, select the plating object you wish to update.

4. The plating object you have selected should automatically update to use the new face selection.

4.6.2 Copy Plating

Fig. 28: Copying a plating object to a new selection area.

This will copy a plating object to a new set of faces on the object.
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1. On the main object you are creating plate objects from, select a new set of faces in Face Edit Mode.

2. Right-click and select Plating Generator -> Copy Plating From:.

3. In the menu that appears, select the plating object you wish to update.

4. The plating object you have selected should automatically be copied and pointed to use the new face selection.

4.6.3 Select Faces for Plates

Fig. 29: Getting the plating selection for a plating object.

When in Face Edit mode on the main object, this will get the selection for a plating object associated with it.

1. On the main object you are creating plate objects from, right-click and select Plating Generator -> Select Faces
For:.

2. In the menu that appears, select the plating object you wish to get the face selection for.

3. The main object should update its face selection to the faces that are associated with the selected plating object.

4.7 Presets

You can save your own effects that you can then re-use or share.

The add-on comes bundled with some pre-configured presets, and you can also create your own.

Fig. 30: An example of using presets to automatically apply a variety of effects to build on.

Each workflow contains its own separate set of presets.
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4.7.1 Non Destructive Workflow Presets

Save a Preset

1. With the plating object selected, in the top right of the Plating Generator panel is the presets sub-menu. Select
“Save Preset”:

2. In the File Menu window that appears, type the name of the .json file you wish to save as a preset. You may wish
to save in a pre-configured directory for easy access later:

3. Click “Save”.

Your settings will be then saved as a .json file you can load later or access via a sub menu if you have saved it in a
presets directory.
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Load a Preset

1. With a plating object selected, in the top right of the Plating Generator panel, go to the the presets sub-menu
and select “Load Preset”:

2. In the File Menu that appears, select the .json file of the preset you wish to load:

3. Click “Load”.

This will update the selected Plating object’s settings with the preset.

Quickly apply a Preset

A pre-bundled preset, or a preset file in your presets directories, can be quickly added in two ways:

1. Create an object with the preset instantly applied via the right-click menu, under Plating Generator -> Add
Preset:
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2. Change an existing object to use a preset through the top menu in the side panel:

Custom presets directories

Placing your json preset files in a pre-configured directory gives you quick access via the drop down menus. You can
have many presets directories, each containing their own group of presets.

These directories can be set in the Presets Path setting under the Edit - Preferences - Addons menu under the Plating
Generator add-on entry:

4.7.2 Destructive Workflow Presets

Add Preset

Press the + button at the top of the pop-up menu, enter a name for the preset and click ‘OK’.
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Fig. 31: Adding a Preset

Delete Preset

With the Preset loaded, click the - button next to the preset dropdown.

Fig. 32: Deleting a Preset

Apply Preset

With a Plating Object selected, click the name of the entry in the Presets menu:

4.8 Greeble Libraries
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Fig. 33: Applying a Preset
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You can create your own greeble libraries that can be loaded into Blender.

4.8.1 Installing a Greeble Library

1. Go to Edit -> Preferences and select the Add-Ons tab if it is not selected already:

2. Then, find the Plating Generator add-on by starting to type ‘Plates. . . ’ in the search box. Expanding the ‘Mesh:
Generate Plates with Greebles’ entry should give you a small preferences screen:
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3. There is a ‘Preferences’ section:

4. The Defaults are listed in their own directory. If you delete all entries, clicking ‘Refresh Libraries’ will reset the
directory list.

5. To add a new library, unzip the zip file to a separate folder somewhere on your computer. You should see a set
of files with .blend and .png file pairs:
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6. Now go to the preference screen and click the ‘Add Folder Containing Greebles’ button. A new folder entry will
appear:

7. Finally, click ‘Refresh Greeble Libraries’ to load the greebles in:

You should now be able to use the new greebles library when using the add-on by selecting the library from the drop
down list:

Fig. 34: Credit:

60 Chapter 4. How does it work?



Plating Generator

4.8.2 Making a Greeble Library

You can create your own greeble library by doing the following:

1. Create a folder for your greeble library. The name of the folder will be the name of the library.

2. Create a .blend file with the Greeble object in it.

3. Greeble objects need to be a single blender object mesh, that is:

• It does not have child objects and is all joined into one object.

• All modifiers are applied.

• It is a normal blender ‘Mesh’, not a curve, a light, or other object types.

• It can optionally have Materials and UV Mapping.

4. Make sure the object is called ‘Greeble’. This is so the add-on can find the object when it looks in the file.

5. Create a thumbnail for the file by rendering a square picture of it in Blender and saving it as a .png in the same
directory as the .blend file. It should also have the same name as the .blend file. For instance, if my greeble object
is called my_greeble I would have a my_greeble.blend file and a square my_greeble.png file of, for instance,
500x500px in the one directory.

6. You can create as many .blend-.png pairs of files in the folder, and this will make up your greeble library.

A good way of seeing what a greeble folder should look like is by looking at the contents of the custom_greebles.zip
example file. There are example scenes that that you could copy:

Fig. 35: Credit:

If you have any issues do not hesitate to get in touch via info@configurate.net.
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4.9 Animation Nodes

There is also the option to use the add-on as a node in the powerful Blender extension. This is useful if you want to
either create animated effects or control the effect dynamically.

There are two available nodes: One for generating plates and one for generating greebles separately.

The Properties are similar to those of the main add-on.

The ‘Generate Plates’ node looks like this:

And the ‘Add Greebles’ Node looks like this:

If you have a question, issue, or new feature do not hesitate to get in touch via info@configurate.net.

4.10 Iterator

To assess many possible combinations, the Iterator feature can use the camera in your scene to automatically render a
range of Plating Generator master seed combinations to a directory of your choosing.
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Fig. 36: Animation Nodes Panel for Plates
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Fig. 37: Animation Nodes Panel for Greebles
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Fig. 38: Iterator Controls.

4.10.1 Using the Iterator

The iterator will produce a set of images, each image is a preview of the Plating Object when it is in that seed configu-
ration.

The name of the filename will display the master seed value used.

• Seed Range: set the master seed range used to render out different combinations.

• File Path: The output directory for the file images.

• Render Engine: Optionally choose a render engine different to the main scene. The Iterator will then use the
settings of the alternative renderer.

• Start: start an iterator process. Whilst the images are rendering, Blender may appear to freeze. You can check
whether the images are being output by navigating to the output directory to see if the images are being created.
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4.10.2 Cancelling the operation

Whilst running, there is a file called running.ack that you can use to stop the iterator and unfreeze Blender. Remove
running.ack, and after rendering an image Blender will check for the presence of this file. If this file no longer exists,
it will cancel the operation.

This is similar to the iterator function in KIT OPS SYNTH.
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4.11 Modifiers

The Plating Generator comes with a set of modifiers that add panelling effects and greebles on top of the base mesh,
also in a non-destructive way.

• These are completely separate to the other Plating Generator workflows.

• They require a grid shaped UV Map to work.

• The modifiers use, but do not require knowledge of, . However by learning a little you will get the most out of
them.

Tip: Advantages

• Fast: As the modifiers use Blender’s core processes, they are a lot faster than the standard Python add-on func-
tions. They will also work on meshes with larger numbers of faces.

Fig. 39: Captured in realtime, the modifier can out perform standard python.

• Flexible: As they are modifiers that use Geometry Nodes, you can use them with Blender’s other modifiers or
use them as a node with other Geometry Nodes.

• Non-destructive: The modifiers do not alter the base mesh and will update automatically when the base mesh
changes.

• Animatable: The parameters of the modifiers can be animated using keyframes.

Disadvantages

• UV Map Required: The panel modifiers specifically require a grid shaped UV Map for them to work, otherwise
nothing will be displayed. You can use the add-on to achieve this or by using the method. Remember, you can
add more than one UV Map to an object in Blender’s tab if you already have a UV Map you wish to keep.
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Fig. 40: The ideal UV Map is made up of a square grid for the pattern to work well. Here, the add-on is used to make
the UV faces square.

Fig. 41: Remember you can create more than one UV map under the Object Data Properties tab.

• Quad topology ideal: Ideally the geometry should be arranged in quad topology.

• Limited features: As Geometry nodes is still evolving, the modifier parameters are comparatively limited com-
pared to the other Plating Generator workflows.

4.11.1 Using the Modifiers

Add any one of the modifiers by:

1. Selecting the object you wish to add one of the modifiers to. The object requires a square shaped UV map and a
set of faces to extrude.

Tip:

• You could use a Subdivision Surface modifier (optionally set to Simple) to increase geometry for the modifier.
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• You can use selections of faces with the modifier, but it is recommended to separate geometry for different effects.

1. Right-click in the viewport and go to the Plating Generator section of the context menu. There should be a
Modifiers section that lists all current Plating Generator modifiers:

2. Select the modifier you wish to add from the Modifiers section of the menu.

3. The modifier will be added to the object, along with any additional modifiers (e.g. a bevel modifier) that com-
plements the effect. You may wish to adjust parameters like the heights of the panels to make sure the effect is
working.

Warning: If the effect is blank, check you have a UV Map for the object.

Tip:

Fig. 42: A Bevel modifier might be added to highlight the Panelling effect. You can adjust this separately to the main
modifier.
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4.11.2 Modifiers list

There are different modifiers to choose from. Parameters are documented as tooltips on each of the individual inputs:

Panelling Modifier

A base panelling effect that uses a combination of big, medium and small panels controlled by a random seed number.

Plating Modifier

A more customizable version of the panelling modifier, allowing you to set materials and heights for different size
panels. Optional notches are added to the sides for greater detail.

Greebles Modifier

A modifier that adds random objects to the surface. A default collection of objects is imported, which can be changed
to a different collection on the modifier settings.

Pipes Modifier

A modifier that creates a simple random piping pattern.

Tip: Combining modifiers
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Fig. 43: The greebles modifier set to a density of 5000.

4.11. Modifiers 71



Plating Generator

You can combine different modifiers together and use set by the modifiers to change where they are applied. Here a
Plating Modifier has been added first, and then a Greeble Modifier has then been added. The Selection parameter has
then been changed so the greebles only appear on the Small Panels.

This is by using the Small Panels attribute that has been set by the Plating modifier:
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4.11.3 Using the Nodes

Hidden behind each modifier is a set of node groups that can be used inside a Geometry Nodes set up. These node
groups can be loaded into a Blender scene and then used in combination with any other nodes.

To add the nodes for use:

1. Go to the Geometry Nodes editing tab.

2. Add a Geometry Nodes modifier to the object if there is not one already.

3. Click “New” to add a new Geometry Nodes tree to the modifier.

4. In the nodes editor view, right-click and select “Import Plating Generator Geometry Node Groups”. This will
import all node groups if they have not been added already.

5. In the nodes editor view, press shift-A and search for one of the following modifier nodes:

• Panels Modifier Nodes

• Plating Modifier Nodes

• Greebles Modifier Nodes

. . .Any other nodes groups with similar names may be sub-node groups and are less useful.

6. You can then use the node in the same way as the modifier:

Tip:

4.11. Modifiers 73



Plating Generator

74 Chapter 4. How does it work?



Plating Generator

4.11. Modifiers 75



Plating Generator

• Remember to add a UV Map (e.g. from a Named Attribute node - see screenshot) to the Vector
input to supply a UV Map to the node. Otherwise, nothing will be displayed.

• Also make sure the mesh has enough face subdivisions to see a result (as seen in the screenshot)

• Adjust parameters (e.g. height) on the node to check it is working.

4.11.4 Having issues with the modifiers or nodes?

Don’t hesitate to Get in touch

4.12 Baking

When you are finished with the Plating Object and no longer want it to be changed by the panel, you can click the
‘Collapse Plating Object’ to remove Plating Generator specific properties.
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4.13 Contact

If you have a question, issue, or new feature do not hesitate to get in touch via info@configurate.net.
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